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Safety

 

Documentation User
Attention Words

 

Five user attention words appear in the text of all Applied Biosystems user 
documentation. Each word implies a particular level of observation or action as 
described below.

 

Note

 

Calls attention to useful information.

 

IMPORTANT

 

Indicates information that is necessary for proper instrument operation.

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury. It may also be used to alert against unsafe practices.

Indicates a potentially hazardous situation which, if not avoided, could result in 
death or serious injury.

Indicates an imminently hazardous situation which, if not avoided, will result in 
death or serious injury. This signal word is to be limited to the most extreme situations.

 

Chemical Hazard
Warning

 

CHEMICAL HAZARD

 

. Some of the chemicals used with Applied Biosystems 
instruments and protocols are potentially hazardous and can cause injury, illness, or death.

 

�

 

Read and understand the material safety data sheets (MSDSs) provided by the 
chemical manufacturer before you store, handle, or work with any chemicals or 
hazardous materials.

 

�

 

Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (

 

e.g.,

 

 safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

 

�

 

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (

 

e.g.

 

, fume hood). For additional safety guidelines, 
consult the MSDS.

 

�

 

Do not leave chemical containers open. Use only with adequate ventilation.

 

�

 

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the 
manufacturer’s cleanup procedures as recommended on the MSDS.

 

�

 

Comply with all local, state/provincial, or national laws and regulations related to 
chemical storage, handling, and disposal.

 

Chemical Waste
Hazard Warning

 

CHEMICAL WASTE HAZARD

 

. Wastes produced by Applied Biosystems 
instruments are potentially hazardous and can cause injury, illness, or death.

 

�

 

Read and understand the material safety data sheets (MSDSs) provided by the 
manufacturers of the chemicals in the waste container before you store, handle, or 
dispose of chemical waste.

 

�

 

Minimize contact with chemicals. Wear appropriate personal protective equipment 
when handling chemicals (

 

e.g.,

 

 safety glasses, gloves, or protective clothing). For 
additional safety guidelines, consult the MSDS.

 

�

 

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use 
only with adequate ventilation (

 

e.g.

 

, fume hood). For additional safety guidelines, 
consult the MSDS.

 

�

 

Handle chemical wastes in a fume hood.

CAUTION!

WARNING!

DANGER!

WARNING!

WARNING!
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�

 

After emptying the waste container, seal it with the cap provided.

 

�

 

Dispose of the contents of the waste tray and waste bottle in accordance with 
good laboratory practices and local, state/provincial, or national environmental 
and health regulations.

 

Ordering MSDSs

 

You can order free additional copies of MSDSs for chemicals manufactured or 
distributed by 

 

Applied Biosystems

 

 using the contact information below

 

.

 

For chemicals not manufactured or distributed by Applied Biosystems, call the 
chemical manufacturer.

 

To order MSDSs... Then...

 

Over the Internet a. Go to our Web site at 
www.appliedbiosystems.com/techsupp

b. Click 

 

MSDSs

 

c. You can open and download a PDF (using Adobe

 

®

 

 
Acrobat

 

®

 

 Reader

 

™

 

) of the document by selecting it, or 
you can choose to have the document sent to you by fax 
or email.

By automated telephone 
service

Use “To Obtain Documents on Demand” under “Technical 
Support.”

By telephone in the United 
States

Dial 

 

1-800-327-3002

 

, then press 

 

1

 

.

By telephone from Canada

If you have... Then...

The MSDS document 
number or the Document 
on Demand index number

Enter one of these 
numbers in the 
appropriate field on this 
page.

The product part number Select Click Here, then 
enter the part number or 
keyword(s) in the field on 
this page.

Keyword(s)

To order in... Dial 1-800-668-6913 and...

English Press 1, then 2, then 1 again

French Press 2, then 2, then 1
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Microsatellites

 

Overview of
Microsatellites

 

Microsatellites can be used for a variety of applications such as human disease 
research, mouse mapping, population genetics, etc.

The ABI P

 

RISM

 

®

 

 Linkage Mapping Set is an example of microsatellite analysis.The 
compilation of 811 highly informative dinucleotide markers can be used for linkage 
disequilibrium, association studies, and population genetics. Between 15 to 20 loci 
can be multiplexed post PCR amplification and co-electrophoresed in one capillary. 
For optimal resolution, as in the case of fine mapping, Applied Biosystems 
recommends using the 36-cm capillary array. However, the 22-cm capillary array can 
be used to rapidly scan the genome when using markers less than 360 bp.

 

Throughput

 

There is a greater than two-fold increase in throughput using the 22-cm capillary array.

 

a. five loci/color x three colors

b. five loci/color x four colors

 

Limitations

 

�

 

Peak Height

Due to the shorter separation, the 22-cm capillary array shows a 50–60% 
increase in peak height. It is recommended that users re-optimize dilution and 
pooling ratios to avoid generating offscale data (Y-axis value greater than 
8192 RFUs).

 

�

 

Precision

The sizing precision is similar to the 36-cm capillary array; yielding ±0.15 bp 
standard deviation for up to 350 bp.

 

�

 

Sizing

When compared to the 36-cm capillary array, all fragments sized on a 22-cm 
capillary array demonstrated an increased interpolated size between 0.4–0.6 bp. 
This is due to the mobility shifts.

 

�

 

Size Range

For dinucleotide repeats, Applied Biosystems recommends restricting marker size 
range between 75–350 bp. Tri- and tetranucleotide repeats can contain alleles 
between 75–400 bp.

 

�

 

Multiplexing

Between 15–20 loci can be multiplexed depending on the dye set utilized
(four versus five dyes). Applied Biosystems recommends a minimum of 10 bp 
spacing between loci in the same color.

 

�

 

Resolution

The resolution is 1 bp up to 250 bp, and 2 bp up to 360 bp. 

 

Array 
Length

Number of 
Dyes

Run Time 
(Min)

Runs/
24 Hours

Number of 
Capillaries

Number of 
Loci

Genotypes/
24 Hours

 

22-cm 4 21 72 16 15

 

a

 

17,280 

5 21 72 16 20

 

b

 

23,040

36-cm 4 45 32 16 15 7,680

5 45 32 16 20 10,240
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ABI P
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 SNaPshot Multiplex System

 

Overview of
SNaPshot Multiplex

Kit

 

The ABI P

 

RISM

 

®

 

 SNaPshot™ Multiplex Kit is a tool to rapidly validate suspected single 
nucleotides polymorphisms (SNPs). It is designed to interrogate up to ten SNPs in 
one capillary thereby increasing throughput.

The chemistry is based on dideoxy single-base extension of an unlabeled 
olignucleotide primer (or primers).

 

�

 

Each SNP primer binds to a complementary template in the presence of 
fluorescently labeled ddNTPs and AmpliTaq

 

®

 

 DNA Polymerase, FS.

 

�

 

The polymerase extends the primer by one nucleotide, adding a single ddNTP to 
its 3´ end.

 

Dye Assignments

 

The fluorescent dyes are assigned to the individual ddNTPs as follows:

 

Throughput

 

The 22-cm capillary array allows 2X increase in throughput without compromising 
precision, resolution or multiplexing capability.

 

Limitations

 

�

 

Peak Height

Due to the shorter separation, the 22-cm capillary array shows a 40–50% 
increase in peak height. It is recommended that users load 0.5 µL SNaPshot 
Multiplex product per capillary to avoid generating offscale data (Y-axis value 
greater than 8192 RFUs).

 

�

 

Precision

Using the SNaPshot Multiplex protocol, Applied Biosystems supports ±0.5 bp 
standard deviation.

 

�

 

Size Range and Multiplex Scheme

For SNaPshot Multiplex, the rules for the 36-cm capillary array apply to the 22-cm 
capillary array. This includes restricting SNaPshot Multiplex product between 
20–105 bp. Additionally, loci less than 36 bp should be spaced a minimum of 6 bp 
apart, while loci greater than 36 bp should be spaced 4 bp apart.

 

ddNTP Dye Label Color of Analyzed Data

 

A dR6G Green

C dTAMRA™ Yellow (Black)

G dR110 Blue

T (U) dROX™ Red

– LIZ™ Orange

 

Array 
Length

Run Time 
(Min)

Runs/
24 Hours

Number of 
Capillaries

Number of 
Loci

Genotypes/
24 Hours

 

22-cm 15 96 16 10 15,360

36-cm 30 48 16 10 7,680
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Chemistry Information

 

Required Reagents

 

The procedures require the following:

For kit and reagent part numbers, and information on custom oligos, refer to “Ordering 
Information” on page 18.

 

Chemical Hazards

 

CHEMICAL HAZARD

 

. 

 

10X Genetic Analyzer Buffer with EDTA 

 

may cause 
eye, skin, and respiratory tract irritation. Please read the MSDS, and follow the handling 
instructions. Wear appropriate protective eyewear, clothing, and gloves.

 

CHEMICAL HAZARD

 

.

 

 Formamide 

 

causes eye, skin, and respiratory tract 
irritation. It is a possible reproductive and birth defect hazard. Please read the MSDS, and 
follow the handling instructions. Wear appropriate protective eyewear, clothing, and gloves.

 

CHEMICAL HAZARD

 

. 

 

POP-4 polymer

 

 may cause eye, skin, and respiratory 
tract irritation. Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves. Use for research and development purposes only.

 

\

 

Supported
Applications

 

Description Part Number

 

10X Genetic Analyzer Buffer with EDTA 402824

22-cm Capillary Array 4319898

Hi-Di™ Formamide 4311320

3100 POP-4 Polymer 4316355

CAUTION!

WARNING!

CAUTION!

Dye Set Kit Application

DS-02 SNaPshot™ Multiplex Kit High throughput SNP scoring

DS-30 Custom oligos Microsatellites only

DS-31 Linkage Mapping Set, mouse and 
custom oligos

DS-33 5-Dye Linkage Mapping Set and 
custom oligos
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Software Information

Software
Prerequisites

The three software requirements for using the 22-cm capillary array are:

� ABI PRISM® 3100 Data Collection Software, version 1.0.1

� ABI PRISM® DNA GeneScan™ Analysis Software, version 3.7

� ABI PRISM 3100 22-cm Array Software Support Files CD-ROM (P/N 4331860)

Contents of the CD To use the 22-cm capillary array on the 3100 instrument, new modules are required. 
These files are located on the CD-ROM.

The CD contains:

� ABI PRISM® 3100 22-cm Array ReadMe file

� 22-cm method files:

– Spect22_POP4.mtd

– SNP22_POP4.mtd

– GeneScan22_POP4.mtd

Installing the New
Files

When the installation is complete, the method files are placed in the storage location 
listed below. Confirm proper installation by navigating to the following directory:

a. A script contained on the CD automatically converts the method files into module files, and imports 
the module files into the database.

To install the new files: 

Step Action

1 Start or restart the computer. Make sure the OrbixWeb Daemon is running.

2 Insert the ABI PRISM 3100 Genetic Analyzer Software Support Files CD-ROM.

The installer starts automatically.

3 In the 22-cm Array Support Files Installer window, click Next.

4 In the next window, open the OrbixWeb Daemon if you have not done so in step 1. 
Click Next.

The methods are automatically stored on the D drive and are then imported into the 
database.

5 Click Finish to complete the installation.

6 Remove the CD-ROM.

7 Restart the computer.

File Storage Location

Spect22_POP4.mtda D:\appliedbio\Support Files\Data Collection 
Support Files\Method FilesSNP22_POP4.mtd

GeneScan22_POP4.mtd
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Preparing the Instrument

Using the Install
Array Wizard

The current Install Array wizard does not include the 22-cm capillary array length 
option button. Use the 36-cm capillary array length option button instead.

To install the capillary array:

Step Action

1 Make sure your polymer blocks, tubing, and syringes are clean and dry.

Note A Polymer Block Cleaning Kit (P/N 432291) is available to more easily clean 
the upper and lower polymer blocks. 

2 Place the clean upper and lower polymer block on the 3100 instrument, and 
connect the blocks with the polymer tubing.

3 With the instrument doors closed, press the Tray button.

4 From the Tools menu, select Install Capillary Array Wizard.

5 Follow the directions in the wizard to:

a. Input the capillary’s length and serial number.

Note Use the 36-cm option button and type in the serial number of your 22-cm 
array.

b. Install the capillary array.

Note There is no capillary array holder for the 22-cm array, therefore position the 
comb as shown below. Do not remove the comb as it spaces the capillaries apart 
and allows for minimal overlap between adjacent capillaries.

c. Fill the reservoirs and anode reservoir.

d. Fill the syringes with 3100 POP-4 polymer and install the syringes onto the 3100 
instrument.

e. Prime the polymer blocks with polymer and remove all bubbles.

f. Fill the capillary array with polymer.

g. Replace the buffer in the anode reservoir.

Position the comb as shown here
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Calibrating the Instrument

Performing a Spatial
Calibration

Perform a spatial calibration as usual. Refer to Chapter 4 in the ABI PRISM 3100 
Genetic Analyzer User Guide (P/N 4315834) for details.

Performing a
Spectral Calibration

Using Matrix
Standards

Determining Which Matrix Standard and Dye Sets to Use

Use the table below to determine which matrix standards to use and what dye set to 
select.

Performing the Spectral Calibration 

Application Dye Set
Matrix 

Standard Kit Dyes

SNaPshot Multiplex E5 DS-02 dR110, dR6G, dTAMRA™, 
dROX™, LIZ™

Custom oligos D DS-30 6-FAM, HEX, NED™, ROX

� LMS v2.5

� Mouse

� Custom oligos

D  DS-31 6-FAM, VIC™, NED, ROX

� 5-Dye LMS v2.5

� Custom Oligos

G5 DS-33 6-FAM, VIC, NED, PET™, LIZ

To perform a spectral calibration using matrix standards: 

Step Action

1 Thoroughly mix the matrix standards. 

2 Prepare the matrix standards according to the instructions in the product insert for 
the specific dye set you are using.

CHEMICAL HAZARD. Formamide causes eye, skin, and 
respiratory tract irritation. It is a possible reproductive and birth defect hazard. 
Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

3 Dispense 10 µL of the standard and formamide mixture into a 96-well plate, using 
wells A1 through H2.

4 Assemble the plate and place the plate assembly onto the autosampler.

5 Within the Plate View page of the 3100 Data Collection software, click New.

a. In the Plate Name text box, type a name for the plate.

IMPORTANT Use letters and numbers and the following punctuation only: -_()#.+.
Do not use spaces.

b. For the Application, select Spectral Calibration.

c. For the Plate Type, select 96-Well.

d. Click Finish.

This opens the Plate Editor spreadsheet.

WARNING!
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6 To complete the Plate Editor spreadsheet:

a. In the A1 cell, type a name for the samples.

IMPORTANT Use letters and numbers and the following punctuation only: -_()#.+. 
Do not use spaces.

b. Select the rest of the options using the table below.

c. Fill down each column to H2.

d. Click OK.

7 In the Pending Plate Records table, select the plate record that you just created.

8 Click the plate graphic that corresponds to the plate you are linking.

This links the plate record to the plate position. The plate position indicator changes 
from yellow to green and the entry for the plate record moves to the Linked Plate 
Records table.

9 Click the Run button.

10 Review the quality of your spectral calibration.

11 Proceed with “Preparing For a Run” on page 11.

To perform a spectral calibration using matrix standards: (continued)

Step Action

Column Heading Application Select…

Dye Set SNaPshot Multiplex E5

� LMS v2.5

� Mouse

� Custom oligos

D

� 5-Dye LMS v2.5

� Custom Oligos

G5

Run Module All Spect22_POP4DefaultModule

Spectral Parameter SNaPshot Multiplex MtxStd{GeneScan-SetE5}.par

� LMS v2.5

� Mouse

� Custom oligos

MtxStd{GeneScan-SetD}.par

� 5-Dye LMS v2.5

� Custom Oligos

MtxStd{GeneScan-SetG5}.par
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Preparing For a Run

Preparing and
Loading Samples

Creating a Plate
Record and Linking

a Plate

To prepare and load samples:

Step Action

1 Pool the PCR/SNP products according to the kit protocol.

2 Combine the following:

CHEMICAL HAZARD. Formamide causes eye, skin, and 
respiratory tract irritation. It is a possible reproductive and birth defect hazard. 
Please read the MSDS, and follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

3 Heat denature the samples at 95 °C for 5 min.

4 Immediately place the samples on ice.

5 Load the samples in the plate and assemble the plate.

6 Place the plate assembly onto the autosampler.

Application Product Size Standard Hi-Di Formamide

PCR 1 µL 0.5 µL 10 µL

SNP 0.5 µL 0.25 µL 9.25 µL

WARNING!

To create a plate record and to link the plate: 

Step Action

1 From the Plate View page of the 3100 Data Collection software, click New.

This opens the Plate Editor dialog box.

2 In the Plate Editor dialog box, enter the plate name, the application, and plate type.

a. In the Plate Name text box, type a name for the plate.

IMPORTANT Use letters and numbers and the following punctuation only: -_()#.+.
Do not use spaces.

b. Use the default selection, GeneScan, for the Application.

c. In the Plate Type drop-down list, select the appropriate plate size.

d. Click Finish.

This opens the Plate Editor spreadsheet.
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3 Use the table below to complete the columns of the plate editor spreadsheet.
s.

To create a plate record and to link the plate: (continued)

Step Action

For… Column Heading Select…

Dye Set E5 Sample Name Type in the names of all samples

Dye O (orange)

Color Info User defined

Color Comment User defined

BioLIMS Project 3100_Project1

Dye Set E5

Run Module SNP22_POP4DefaultModule

Analysis Module GS120Analysis.gsp

Dye Set D Sample Name Type in the names of all samples

Dye R (red)

Color Info User defined

Color Comment User defined

BioLIMS Project 3100_Project1

Dye Set D

Run Module GeneScan22_POP4DefaultModule

Analysis Module GS400HDAnalysis.gsp or 
GS500Analysis.gsp

Dye Set G5 Sample Name Type in the names of all samples

Dye O (orange)

Color Info User defined

Color Comment User defined

BioLIMS Project 3100_Project1

Dye Set G5

Run Module GeneScan22_POP4DefaultModule

Analysis Module GS500Analysis.gsp
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4 � An example of a completed linkage mapping plate record is shown below.

� An example of a completed SNP plate record is shown below.

Click OK when you are done.

To create a plate record and to link the plate: (continued)

Step Action



Page 14 of 20 ABI PRISM 3100 22-cm Capillary Array for High Throughput Microsatellite and SNP Genotyping

Starting the Run

Starting the Run

5 In the Pending Plate Records table, select the plate record that you just created.

6 Click the plate graphic that corresponds to the plate you are linking.

This links the plate record to the plate position. The plate position indicator changes 
from yellow to green and the entry for the plate record moves to the Linked Plate 
Records table.

To create a plate record and to link the plate: (continued)

Step Action

To start the run:

Step Action

1 Click the Run button.

2 Click the Status View tab and monitor the status of the instrument.

The run time for:

� Microsatellites is 21 min 

� SNP is 15 min

IMPORTANT To prevent screen refresh problems, do not leave the Array View or 
Capillary View pages open for extended periods during a run.
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Analyzing the Data

Software Required Conduct data analysis using the following:

� ABI PRISM® GeneScan Analysis Software version 3.7

� Analysis parameters and size standards

� ABI PRISM® GenoTyper™ Software version 3.7 or

� ABI PRISM® GeneMapper™ Software version 2.0

Conducting Data
Analysis

Refer to the ABI PRISM DNA GeneScan Analysis Software version 3.7 Users Guide 
(P/N 4308923) for instructions on how to analyze data from a GeneScan run.

SNaPshot data can be analyzed using ABI PRISM GenoTyper version 3.7. Refer to the 
GenoTyper for SNaPshot User Bulletin for details.

Editing the Analysis
Parameters

Some applications involving di-, tri- and tetranucleotide repeats may require the 
Analysis Parameters in the analysis module to be modified for proper analysis.

Application Size Standard Analysis Modules

SNaPshot Multiplex GS 120.szs GS120Analysis.gsp

Custom oligos GS 400HD.szs GS400HDAnalysis.gsp

� LMS v2.5

� Mouse

� Custom oligos

GS 400HD.szs or 
GS500-250.szs

GS400HDAnalysis.gsp or 
GS500-250Analysis.gsp or 

custom

� 5-Dye LMS v2.5

� Custom Oligos

GS500.szs or 
GS500-250.szs

GS500Analysis.gsp or custom

To edit the analysis parameters: 

Step Action

1 Open the ABI PRISM® GeneScan™ Analysis software.

2 From the File menu, select Open.

3 Select the Analysis Parameters icon.

4 a. Select the analysis module you want to edit. The analysis modules are stored in 
the following directory:
D:\appliedbio\Shared\Analysis\Sizecaller\Params

b. Click Open.
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5 The analysis module opens. Select the appropriate settings:

6 Save the changes as a new analysis module.

a. From the File menu, select Save As.

b. Assign a unique name and click OK.

IMPORTANT Store the new analysis modules in the following directory:
D:\appliedbio\Shared\Analysis\Sizecaller\Params

7 Reanalyze your data with the new analysis parameter file.

To edit the analysis parameters: (continued)

Step Action

For…

Value for 
Polynomial 

Degree Size Standard
Peak 

Window Size

Dinucleotides 
repeats

5 Select the appropriate 
size standard:
GS400HD.szs, 
GS500.szs or 
GS500-250.szs

15

Tri- and 
tetranucleotide 
repeats

3 19

Select the appropriate size 
standard

Type 5 for dinucleotide repeats
Type 3 for tri- and tetranucleotide 
repeats

Type 15 for dinucleotide repeats
Type 19 for tri- and tetranucleotide 
repeats 
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Troubleshooting

Troubleshooting
Table

Topic Symptom Solution

Resolution Single base pair resolution 
does not exceed 260 bp. Is 
the array bad?

Short array lengths lead to less 
resolution, therefore the array is only 
supported for 2 applications.

The 22-cm array is guaranteed for 100 
runs.

Peak Detection Adjacent peaks are clearly 
separated peaks; however 
the software calls the entire 
cluster as on peak.

Create a new analysis parameter, refer 
to “Editing the Analysis Parameters” on 
page 15. For dinucleotide repeats 
increase the polynomial degree to 5 
and change peak window size to 15.

Comb Placement The comb does not fit into 
the comb holder for the 
36-cm array.

There is no designated holder for the 
22-cm array. Do not remove the comb. 
Refer to “Using the Install Array 
Wizard” on page 8.

Signal Peak heights are 
significantly greater than 
the 36-cm array sometimes 
yielding offscale data.

Review the raw data for fragments 
greater than 8000 RFUs. These 
products should be diluted to prevent 
offscale data.

If the product is from a:

� Microsatellite application, then 
adjust the pooling ratios.

� SNaPshot multiplex, then reduce 
the amount of PCR product or SNP 
primer in the SNP reaction.

One peak for the cluster, 
polynomial degree = 3

One peak, 
polynomial degree = 5
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Ordering Information

SNaPshot Multiplex
Kit and Reagents

Linkage Mapping
Set v2.5-MD10 and

Mouse Reagents

Custom Oligos Applied Biosystems, the leading supplier of instruments, reagents, and software 
systems for life science research, also provides custom nucleic acid synthesis 
services. This includes: ABI PRISM® primers, Custom ABI PRISM® Sequencing Kits, 
and ABI PRISM® Linkage Mapping Sets.These products are available via Applied 
Biosystems Web site, e-mail, or facsimile, depending on the country.

Description Part Number

SNaPshot Multiplex Kit, 100 reactions 4323151

SNaPshot Multiplex Kit, 1000 reactions 4323154

SNaPshot Multiplex Kit, 5000 reactions 4323155

GeneScan™-120 LIZ™ Size Standard 4324287

Matrix Standard Set DS-02 4323014

Description Part Number

Linkage Mapping Set, 50 reactions 4329186

Linkage Mapping Set, 300 reactions 4329185

Linkage Mapping Set, 1200 reactions 4329184

GeneScan™-500-LIZ™ Size Standard 402985

Matrix Standard Set DS-33 4323016

GeneScan®-400HD ROX™ Size Standard 402985

Matrix Standard Set DS-30 4316100

VIC™ Matrix Standard 4323022
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